
Adobe Acrobat 4.0 for Macintosh ReadMe                           March 15, 1999

This file contains last-minute product information and updates to the Adobe(R) Acrobat(R) 4.0
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Important: Registration

Please complete your registration card and mail it today or use the online registration software provided with
Adobe Acrobat to register your copy. You must register to receive technical support and important product
update information.

Serial Numbers

If you have purchased an Upgrade version of Acrobat, please use the Serial Number from your previous
version of Acrobat.

If you have purchased a new copy of Acrobat, you can find the serial number on the registration card and on
the first page of the Getting Started guide. Use this new number to initialize the program. Do not use the
number on the bottom of the Adobe Acrobat box, since this serial number does not include the checksum
required for serial number validation. If your serial number does not work, please contact Adobe Customer
Support.

System Requirements

System Requirements for Acrobat 4.0 Macintosh
- Apple Power Macintosh computer
- Apple System Software version 7.5.3 or later for Acrobat
- 6 MB of RAM for Acrobat (12 MB recommended)
- 16 MB of RAM for Distiller or the Paper Capture plug-in (32 MB recommended)
- At least 60 MB of available hard disk space
- Additional 50 MB of hard disk space for Asian Fonts (optional)
- A CD-ROM drive

System Requirements for Acrobat Reader 4.0 Macintosh
- Apple Power Macintosh computer
- Apple System Software version 7.1.2 or later
- 4.5 MB of RAM available to Acrobat Reader (6.5 MB recommended)
- 8 MB of available hard disk space



Installation Instructions

Installing Acrobat 4.0 for Macintosh
To install Acrobat 4.0, follow these steps:

Uninstall Acrobat 3.x if desired.
Make sure you have at least 60 MB of available disk space for an Easy installation of Acrobat 4.0
Double click on the Acrobat 4.0 installer located at the top level of the Acrobat CD-ROM.

If you have trouble installing Acrobat, you may not have sufficient space. The amount of available disk space
reported by the installer may not be correct.  If the installer fails to complete an installation due to a lack of
disk space, quit the installer, and check the amount of available disk space in the Finder.

To successfully install Acrobat it is best to minimize the number of extensions that are loaded before running
the installer.  To do this using Extensions Manager, select the set of base extensions for the version of the
MacOS you are running and then restart your computer.  Speed Doubler is one extension that is known to
conflict with the installer.

Installing Acrobat Reader 4.0 for Macintosh
To install Acrobat Reader 4.0, follow these steps:

Uninstall Acrobat Reader 3.x if desired.
Make sure you have at least 10 MB of available disk space for an installation of Acrobat Reader 4.0
Double click on the Acrobat Reader 4.0 installer

Installing the Asian Font Packs for Acrobat 4.0
Asian Font Packs are available for Acrobat Reader 4.0. With any language version of Acrobat Reader 4.0,
you can display Adobe Portable Document Format (PDF) files that contain text in Chinese Simplified,
Chinese Traditional, Japanese, and Korean (CJK). If the author of a PDF file embeds CJK fonts in the
document, then any language version of Reader 4.0 will be able to display the CJK text on any system
without additional software. If the author uses CJK fonts but does not embed them in the document, then
you will need access to the correct Asian fonts in order to view the PDF file on non-native systems. All you
need to do is install the appropriate Asian font pack for use with Acrobat Reader.

The Asian Font Packs are available on the Acrobat 4.0 Product CD, or from Adobe’s web site at:
http://www.adobe.com/prodindex/acrobat/cjkfontpack.html

STSong™ is a trademark of ChangZhou SinoType Technology Co., Ltd

Asian Font Pack installer will only install to one Acrobat Folder
If you have more than one copy of Acrobat on your system the Asian Font pack installation will only install
fonts into a single Acrobat folder. You may manually copy the installed fonts which are located in Adobe
Acrobat (Reader) 4.0 / Resource / CIDFont
[289100]

Troubleshooting Issues

VIEWING

Using Acrobat 3.0 or Acrobat Reader 3.0 to view and print files created in Acrobat 4.0
You can use Acrobat 3.0 or Acrobat Reader 3.0 to view and print PDF files created with Acrobat 4.0, taking
note of the following.
 *  If you are viewing PDF files created with Acrobat 4.0 that contain Asian language text, you will need to
view and print these files with Acrobat 4.0 or Acrobat Reader 4.0.



 * If when creating PDF files using Acrobat 4.0 the default settings in Distiller were changed to take
advantage of advanced PDF features for color management or high quality printing, you will need to view
and print these files using Acrobat 4.0 or Acrobat Reader 4.0.
* If you are authoring PDF forms in Acrobat 4.0, you will need to design these forms with backwards
compatibility in mind for it to work reliably in version 3.0.(see the Forms JavaScript Guide for details)
*  If you are viewing PDF files created with Acrobat 4.0 that contains mark ups such as highlighting,
underlining, strikethrough, pencil strokes, etc. and these mark ups have associated text notes, you will need
to view these files with Acrobat 4.0 or Acrobat Reader 4.0 to be able to double click on the markings and
open and view the text notes. (General Text Notes applied to a document can be opened and read with no
issues in version 3.0)
* If you are using Acrobat 3.0 or Acrobat Reader 3.0 to search an index created with Acrobat 4.0 Catalog,
you should obtain document information from the General Info dialog (accessible by selecting
File>Document Info>General) rather than the Document Info dialog (accessible from Edit>Search>Results).
In some cases, these dialogs may differ slightly.
[273764]

Using Acrobat 4.0 for Macintosh with Internet Explorer
To view PDF files using Macintosh Internet Explorer, you need to keep Acrobat configured as a helper
application. This is set up by default.  Because of compatibility issues, installing the Netscape PDFViewer
browser plug-in for Internet Explorer to use is not recommended.
[293134]

Using Acrobat 4.0 for Macintosh with Netscape Navigator
When using Acrobat 4.0 or Acrobat Reader 4.0 with Netscape Navigator, take note of the following issues:
* Resizing the Netscape Navigator window when a PDF is displayed in a frame may cause problems. If you
encounter these problems, be sure to size the Netscape Navigator window as desired before opening the
PDF.
* Netscape Navigator 4.5 does not support display of PDF files from some secure servers.  PDF files
transferred through secure servers that do not support byte-serving  cannot be displayed.
* If you play movies in a floating window from a PDF file in Netscape Navigator, the audio will play but the
video will not. If you intend for a movie to play from a PDF in Netscape Navigator, make sure the movie is
not set up to play in a floating window.
* Within the web browser window, Acrobat is designed primarily for viewing and filling out forms. To use
interactive features of Acrobat 4.0, such as annotations and mark-up, etc., you will need to run Acrobat
outside of the web browser.
*If you open a PDF file in Netscape 4.x and it appears to hang, you may be encountering a known Netscape
4.x bug. Try reloading the PDF document in Netscape.  If this does not work, use the browser’s “Save As”
menu item to save the PDF file to your local disk, then use Acrobat to open it directly from the local disk.
 [293136]

How to make sure the Euro character will always appear in a PDF
If a PDF uses the Euro character but does not embed the font that includes this character, and this PDF is
viewed on a system that has an older version of the font installed where the Euro character is missing,  the
PDF will be missing all occurrences of the Euro character. To prevent this problem from occurring,  when
you create a PDF that requires the Euro character, be sure to embed the font.  If you  are viewing a PDF
with missing Euro characters, consider updating the fonts on your system to a newer version that contains
the Euro character.
[288428]

Acrobat should be run with virtual memory turned on
Acrobat should be run with Virtual Memory turned on, or it will require more RAM to run.
[278136]

Memory requirements for importing images into Acrobat
To import images into Acrobat, be sure to allocate at least 20 MB of RAM to Acrobat.

Acrobat’s contextual menus are disabled when Apple’s Internet Address Detector is installed
If you install Apple's Internet Address Detector (IAD), you will no longer have access to Acrobat's contextual
menus. To restore access to Acrobat's contextual menus, you can do one of the following:
1) Remove the Apple Data Detectors Extension from the extensions folder and remove the Apple Data
Detectors control panel
2) Hold down the Option key in addition to the Control and Mouse buttons to temporarily disable IAD



3) For IAD 1.0.2, Apple has added a menu item to the bottom of the Help menu of every application that
includes the option to “Turn off(on) Contextual Menu in (name of application)”. In Acrobat, use this menu
item to turn off IAD.
 [278141]

Acrobat and AppleScript creation
Before launching Script Editor, uncheck the "Display Splash Screen at Startup" preference within Acrobat's
General Preferences to prevent problems from occurring.
[290634]

Guidelines for creating worldwide PDFs using the Number Pages feature
When using Acrobat's Document > Number Pages feature to apply special page numbering schemes to a
document, first consider the destination of your PDF.  If you are creating a PDF in an Asian language
version of Acrobat and expect the PDF to be read by others who are running Roman language versions of
Acrobat, on the Page Numbering dialog only enter Prefixes using Roman language characters. Asian
characters may not view and edit properly on Roman systems.
[278010]

Tips for moving pages within a document that uses multiple page numbering methods
When a PDF document contains multiple page numbering methods, if you move a page between sections
using differing methods, the page number will not be updated. To fix this, select Document > Number Pages
and renumber the entire document using one page numbering method, then create new sections with
differing methods.
[277533]

Links in PDF documents should follow proper cross-platform conventions
To reliably create cross document links that work when a PDF travels to a Windows, Macintosh or UNIX
machine, make sure your PDF links only to files with names that follow the ISO 9660 convention.  This
includes the need for file names to be uppercase, 8.3 format, and use a limited character set (no slashes,
spaces, and high ASCII characters).
[288966]

Details about how ATM affects Acrobat’s Font Info dialog
When ATM is installed on the system,  Acrobat's Font Info dialog may occasionally have no entry for  the
Type field.  This occurs if a bitmap font is used.

Viewing and printing PDF files in languages that Acrobat does not directly support.
If you create PDF files in Roman languages, Traditional Chinese, Simplified Chinese, Korean, Japanese,
Hebrew, Arabic, Cyrillic, and Eastern European languages and you choose not to embed all fonts, Acrobat
can display and print files on any system where these fonts are installed. If you create PDF files in Roman
languages, Japanese, Traditional Chinese, Simplified Chinese, Korean and you choose not to embed all
fonts, Acrobat can display and print files even if the fonts are not installed on the system, as long as the files
are in a Roman language or you have installed Acrobat's Asian Language Font Pack.  If you create PDF
files in languages other than those mentioned above, Acrobat needs the PDF files to have the fonts
embedded in order to display or print them properly. We strongly recommend that for maximum document
portability and fidelity that you embed all fonts.
[291335]

Acrobat 4.0 handles some of the base fonts differently than version 3.0
Acrobat 4.0 handles fonts differently than version 3.0. These changes will not affect most users, however if
you want more information on this subject, go to the Adobe support database at
http://www.adobe.com/supportservice/custsupport/main.html and search for document #322792.

PRINTING

Do not print to a PostScript file from Acrobat and distill it
Because of font encoding issues, we recommend that you do not print to a PostScript file from Acrobat and
distill it.  If you insist on doing so, make sure to select a directory for the output file that is different from the
directory containing the original PDF.
[291665]

What to do if stroked curves appear jagged when printed



If you observe jagged curves when printing a file to a PostScript printer, verify that the option to "Use Printer
Halftone Screens" in the Acrobat Print dialog is checked.
[291355]

Correct paper size required in driver setup page to achieve correct print results
If you are not getting the print results that you expect due to a page size mismatch, please check to see that
the paper setting in the printer driver’s setup page is set correctly.
 [286072]

Using the Print As Image option may eliminate printing problems
If Acrobat fails to print a file correctly, try selecting the Print As Image option in Acrobat's Print dialog. This
option, which tells Acrobat to send a 300 dpi raster image to the printer rather than vector art, may enable
troublesome files to print. This option is not, however, recommended for general purpose use because it
may make many PDF files print slower.
[289026]

Resolving out-of-memory issues when printing with AdobePS
When using the AdobePS printer driver on the Macintosh to print a PDF file containing many embedded
fonts, Acrobat may display an "out of memory" error and fail to print the document. If this occurs, increase
Acrobat's memory partition and try printing the document again.
[286337]

Problems when printing or viewing complex or merged PDF files
Merging documents using insert pages may result in documents which may exceed the available memory in
the printer because of possible font duplication. Possible workarounds include:

1) Use “Print as image.”
2) Documents to be merged should have font subsetting turned off
3) Large documents should be created in one Distiller run as opposed to merging chapters. [Refer to

“Combining multiple PostScript files into one PDF file” page 115 in the online version of the user guide]

For FrameMaker users, use the create book feature when generating large documents instead of converting
individual chapters to PDF and then merging chapters together.
[295740]

PostScript Level 1 printing issues
Acrobat 4.0 PDFs which contain LAB based ICC images may not print correctly when printed to PostScript
Level 1 printers. To assure proper printing of these high quality color PDFs, print them to a PostScript 3 or
PostScript Level 2 printer.

On Macintosh PowerPC machines, on rare occasions when printing to PostScript Level 1 printers, Acrobat
may fail to print and display a message saying "You must configure your driver to output Level 1". If this
occurs, try one of the following options:
1)  Select the Print as image option in Acrobat's Print dialog and try printing your file again.
2)  Save your Level 1 PostScript file to disk and use a utility program, for example, the Adobe Downloader
available from Adobe.com,  to download the PostScript file to your Level 1 printer. This works because the
"SaveToDisk" panel of the print dialog lets users set the PostScript level of the PostScript file. (For
interactive printing there is no manual control. Acrobat relies on the driver).
[288587]

When printing to a PostScript Level 1 printer using LaserWriter drivers prior to 8.5.1 you may receive the
error  "The document could not be printed. PostScript error (-8133)." and a printed page that says your
printer driver needs to be configured for PostScript Level 1. To print successfully, either use the AdobePS
driver, which is installed automatically with Distiller or can be installed separately from the Utilities folder on
the Acrobat CD, or use Apple's LaserWriter driver 8.5.1 or later (which you can get from the Apple website at
http://www.apple.com).
[298291]

Some PostScript printing options have limited availability in Acrobat
The PostScript printing options Print Mirror Image, Print Negative Image, Flip Horizontal or Vertical, and
Invert Image are only available in Acrobat if you check the "Print as Image" option in the print dialog.
[283953]



Acrobat may enforce foreground printing of some PostScript files
To assure proper, trouble free printing of some PostScript files, Acrobat may enforce foreground printing
even if you have selected background printing.
[286872]

ANNOTATIONS & FORMS

Open PDFs using Acrobat outside the Web browser to view attached files or hear sound annotations
You can view the File Attachment or Sound icon in the Web browser with the Acrobat 4.0 plug-in.  However,
to open the attached file or play the sound, you need to open the PDF in Acrobat outside the Web browser.
[288715]

Modification date is not updated when the annotation object is resized or moved
The modification date (displayed in the Annotations Properties dialog)  is not updated if the annotation object
is resized or moved.  It is only updated when the associated text note window is changed.
[288704]

Unable to create any new annotation within an existing pencil annotation zone
Within an existing pencil annotation zone, no new annotation can be created unless you temporarily move
the pencil annotation away or resize the pencil annotation zone.
[293401]

Undo is not supported when creating new annotations
Once a new annotation is created, you cannot use Edit->Undo to rollback the creation.  You have to delete
the annotation manually from the document or the annotations palette.
[288707]

In Annotations and Forms Helvetica and Times are substituted if not available
Although Helvetica and Times are always listed as font options in Annotations and Forms, if they are not
available they will be substituted with ArialMT and TimesNewRomanPS, which are installed by Acrobat.
[291264]

Creating Acrobat Forms with appropriate Y2K date fields
The Acrobat Forms plug-in implements a "date horizon" when a field is specified with a date format that only
uses two digits. If the year entered by the user is < 50 then internally forms adds 2000 to the year. If the year
entered by the user is >= 50 then forms adds 1900 to the year. This horizon is implemented so that date
calculations are correct and unambiguous.
Regardless of the internal representation, what the user has typed is sent to the server upon submit or
export of form data. Server side software should be prepared to implement a similar date horizon if form
fields have 2 digit year formats.
It is suggested, however, that authors specify a 4 digit year in a form field to prevent any perceived
ambiguity. If the field is formatted with a 4 digit year then the user must enter all four digits or an error
message will be generated.

How to make sure the Euro character displays within an Acrobat Form
If you have an old version of Helvetica and/or Times fonts without the Euro character and you have Adobe
Type Manager installed, the Euro character may not display in your PDF form. To fix this, either a) turn off
ATM, b) disable Helvetica and Times in ATM, or c) get updated T1 fonts with the Euro character.
[291324]

JavaScript console does not appear in front when using Netscape
When a PDF file containing JavaScript code is viewed in Netscape (for example, some forms in PDF), and
the JavaScript console is summoned, it appears behind the Netscape window, and is invisible to the user.  A
workaround is to view the PDF via the regular Acrobat application rather than within a web browser.
[295162]

MOVIE & IMPORT

How to make sure that sound and movies work properly



If you create links, bookmarks, or any other type of object that plays a sound or movie and they are not
selectable,  install QuickTime 3.0.
[278134]

Use of 16-bit AIF files not recommended
If a 16-bit AIF file with sound is added to a PDF file using the Movie plug-in, it may not play completely.
[287225]

QuickTime must be installed for PICT plug-in to load
QuickTime must be  installed, to enable PICTs to import. If QuickTime is not installed, PICTs will not show
up when importing.
[257899]

TOUCHUP

Issues regarding the TouchUp Text tool and stroke width
If you change the stroke color of text using the TouchUp Text tool, then reduce the text size, the stroke may
become very thick and not reduce with the text size. If this should occur, change the outline color to none,
then reapply the outline color again and the stroke will appear correct.
[286312]

Tips on copying and pasting objects into a PDF page
If you select and copy an object from a PDF page using the TouchUp Object tool, be sure to paste the object
onto a page that is larger than the original page, otherwise you may not be able to see it because it falls
outside the visible area of the new page.
[292626]

Using the TouchUp Text Tool may cause the Font Info dialog to temporarily be incorrect
If you change a font in a PDF document using the TouchUp Text tool, the information in the Font Info dialog
may not immediately reflect the change.  The old and new font names may both be listed in the Font Info
dialog until the file is saved and opened again.
[280520]

Gradient mesh is not passed to Illustrator 8
If you have artwork in a  PDF file that contains a gradient mesh that created in AI8, and you try to edit the
artwork,  the mesh isn’t opened in Illustrator.  There is no workaround.
[296182]

"SaveAs" from Photoshop or Illustrator file menu doesn’t update the image in Acrobat
If you edit an image or artwork in Acrobat in Photoshop or Illustrator, be sure to use “Save” rather than
“Save As” to have the image updated in Acrobat.
[294776]

SCANNING

Memory Requirements for scanning into Acrobat
Acrobat accesses a scanner using either the TWAIN driver or Acquire Plug-in which comes with the
scanner. Most TWAIN drivers and Acquire Plug-ins require that you allocate at least 20MB of RAM to
Acrobat . All TWAIN drivers and Acquire Plug-ins are different and some may require even more memory.

Instructions for Installing Acquire Plug-ins for use with Scanners and Digital Cameras
If using a scanner or digital camera which uses an Acquire plug-in, the Acquire plug-in should be installed to
the following path:  Adobe Acrobat 4.0>Scan>Plug-Ins
[277306]

TWAIN Driver Issues with a variety of scanners
In testing a variety of scanners we found a variety of issues related to data sources provided by 3rd party
vendors’ TWAIN drivers. Behaviors found included infinite loops, messages that "Adobe Acrobat, Could not
complete acquisition because of a problem with the device," and "Unknown device error,"  and "... TWAIN
32, Could not open scanner device." There are a few known problems such as inappropriate dialog boxes



appearing, no dialog appearing and even systems freezing related to bugs within TWAIN drivers and the use
of an ADF (Auto Document Feeder).
If you experience these problems noted above you should check with the scanner vendor to see if updates
are available to their TWAIN drivers.
[289478]
When scanning in Acrobat using a Microtek E6 scanner, due to problems with the TWAIN driver, use the
Acquire plug-in instead. When installing the Microtek ScanWizard driver, make sure you do a manual install
so you can install the Acquire plugin into Acrobat4.0>Scan.
[298074]

Using Digital Cameras with Acrobat 4
You should expect that with most digital cameras all images from the camera will be imported in one step.
This behavior is different than when scanning where a Acrobat dialog box will appear to choose Next to scan
or Done to bring the image into Acrobat.

-- Sony DSC-F1 Digital Camera Issues
Due to an incompatibility between the current  Sony TWAIN source version 1.5 and Acrobat 4.0,  you should
always select ’Done’ when you receive the ’Next/Done’ dialog after a transfer of images. Since the Sony
source allows the transfer of multiple images at once, the inability to select ’Next’ should not hamper the
usability of the Sony TWAIN source with Acrobat. Instead, selecting multiple images will enable the user to
import them all at once without resorting to the ’Next’ option.

-- Kodak Digital DC50 Camera Setup Issues
When setting up a Kodak Digital DC50 Camera for use with the Scan plug-in you should be aware of the
following:
In the Camera Control pop-up window set both the Serial Port and the Connecting Speed to Auto Detect and
click OK.
If communication with the camera fails the first time you might have to retry a few times before the
connection is made.
[289493]

PAPER CAPTURE

Memory Requirements for the Paper Capture plug-in
To use Paper Capture, make sure you have the following available memory:
1) Have at least 16 MB of memory free. To check this under the Apple Menu go to About this Computer.
Largest Unused Block should say 16.0 MB or higher.
2) Have 20 MB of memory allocated to Acrobat 4.0.

It is also recommended that you do not run any other applications other than Acrobat when using the Paper
Capture plug-in in order to maximize use of your memory.

Note:
The above allocation is a basic memory requirement. It may be necessary for you to increase your available
memory to process complicated grey scale or color images. This can be achieved by increasing the
available RAM or Virtual Memory. To increase Virtual Memory please refer to the user guide that came with
your Macintosh. A guideline for estimating your memory needs is as follows:
    Necessary memory = Uncompressed Image Size X 3.

During Paper Capture processing, versions of your document will also be stored as temporary files on your
hard disk.  You will need to make sure you have enough  free hard disk space to complete the Paper
Capture processing.

Example:

File type                             File        Suggested                  Suggested
                                          Size       Additional Memory       Hard Disk

1-bit (black and white)*     1 MB        3 MB                            3 MB
8-bit grey*                          8 MB      24 MB                         24 MB
24-bit color*                      24 MB     72 MB                         72 MB



* - File sizes are based on 8.5x11, 300 dpi, TIFF
[271043]

Paper Capture requires a printer to be selected
If you install Acrobat on a clean System you must first select a printer for Paper Capture to work properly.
You can select any printer including PDFWriter as your selected printer, but you must select the printer
(including PDFWriter) in the Chooser.
[271991, 296974]

Paper Capture requires the system TrueType font Times
The Paper Capture plug-in requires the system TrueType font Times. If this font is not installed, reinstall it
from the Mac OS CD before using Paper Capture.
[296975]

PDFWRITER

PDFWriter vs Distiller
PDFWriter is often simpler and quicker to use. If you are unsatisfied with the quality of the PDF files
generated using PDFWriter, then try using Distiller.
[291993]

PDFWriter and Adobe Illustrator 8
PDFWriter should not be used to generate PDF files from Illustrator 8.0 (user will get error message if this is
attempted). We recommend using  Illustrator’s "Save As PDF" or Distiller to created PDF files.
[291307]

PDFWriter and MacOS 7
Desktop printing in MacOS 7.x may create numerous generic printer icons on the desktop after printing or
doing a Page Setup with PDFWriter.  User may delete printers afterwards, upgrade to MacOS 8, or use
Distiller.
[291305]

PDFWriter and Microsoft PowerPoint
Some PowerPoint files may generate incomplete PDF files (colors and graphics are missing). This is due to
a PowerPoint bug. We recommend using Distiller.
[291299]

PDFWriter and patterns
PDFWriter does not support some pattern types. For example some patterns from Microsoft Word or Adobe
PageMaker will not reproduce accurately in the PDF file. We recommend using Distiller if there are patterns
in your document.
[285140]

Incomplete font information
To get accurate font information for a Type 1 font, PDFWriter requires that the outline font be installed. If
PDFWriter can not find the outline font, an alert box will appear and the resulting PDF file may not correctly
identify the font as serif or sans serif.
[287120]

SimpleText requires more memory
Sometimes a SimpleText document will run out of memory when generating a PDF file, though print fine to a
printer. Simply allocate more memory to the application to resolve this issue.
[271494]

ATM Deluxe 4.0 affects font embedding and encoding
ATM Deluxe can activate different versions of TrueType fonts. This can affect the way fonts are displayed by
providing data on the wrong font set. We recommend turning ATM off when embedding TrueType fonts.
[291542]



DISTILLER

PageMaker 6.5, Export PDF 2.0, and Distiller 4.0
Choosing Export PDF from PageMaker launches Distiller and specifies job options automatically.  However,
the Distiller job options available through ExpPDF.add 2.0 (Win) and Export Adobe PDF.add 2.0 (Mac) were
designed for Distiller 3.x, not 4.0.  With Distiller 4.0 you can simply print directly to Acrobat Distiller by
selecting it as the printer from PageMaker’s print dialog.
[286036]

Distiller will not prompt to replace existing PDF file when you drag-n-drop
Mac Distiller 4.0 will not prompt the user to replace an existing PDF file for drag-and-drop distilling. If you
drag and drop a PS file onto a Distiller alias or the Distiller window, Distiller will not ask you if you want
to replace an existing PDF file that matches the name of the PS file. If you do not want existing PDF files to
be overwritten, then use the File>Open menu or watched folders to distill your files.
[287861]

Auto Rotate Pages is turned off for Print/Press Optimized Job Options
For ScreenOptimized job options setting, Distiller will automatically rotate pages according to the dominate
text orientation. This is done on a page by page basis and makes the files easier to read. For Print/Press
Optimized, this option is turned off to preserve the original orientation and layout of text and graphics for
future printing.
[281609]

Separation information is preserved in the Portable Job Ticket
Distiller does not support direct interpretation of printer systems-based separations (or In-RIP separations).
When Distiller gets a PS file of this type, it will actually create a composite PDF file rather than a separated
PDF file. The separation information will be preserved and passed into the PDF file through a Portable Job
Ticket (PJTF). In the Advanced Panel of the Job Options, make sure "Save Portable Job Ticket in PDF file"
is checked. The actual separation will only take place once the PDF file is passed to a printer or application
that can take the information and apply the separations.
[281244]

TrueType fonts in Adobe Illustrator will always distill as bitmap fonts
Whenever an Illustrator file contains TrueType fonts, the PostScript generated always contains bitmap (Type
3) versions of these fonts, even if you have a PPD selected that contains a TrueType rasterizer. As a result,
the PDF will print okay, but will view poorly, except at the exact resolution for which the font was created.
The workaround is to use the "Save As Acrobat PDF" from the Save As menu in Illustrator instead of
distilling a PostScript file.
[274087]

DISTPARM.PDF and PDFMARK.PDF
The DISTPARM.PDF and PDFMARK.PDF technical notes available from the Distiller help menu are
provided as convenient references for advanced users. The interdocument links within these two files will
not work unless you have the other documents included in the extensive Acrobat SDK document suite. You
can get more information about the SDK from the Developer Support section of the Adobe Web site
(http://partners.adobe.com/supportservice/devrelations/).
[287941]

CATALOG

Issues with Catalog 4.0
Please do not use high-ANSI or the "/" character in file names, index names or descriptions.

The font used by Acrobat Catalog does not support some high-ANSI characters (character codes 133
though 159). Files or folders which contain high-ANSI characters or the "/" character may not be indexed.

Catalog will not index any file beneath a directory with a path length greater than 205 characters, since this
resulting in file path names close to 256 characters. After completing the build, Catalog may claim to have
found new file(s) when in fact it did not add them to the index.



If PDF files are removed from a directory that Catalog has indexed, the file count shown under Acrobat
Search -> Indexes -> info may be out of date. Rebuilding the index should correct the information.

When more than 10 users are searching indexes on a server, the server utilization may reach its maximum,
as the server attempts to read an entire index into its cache.  The workaround is to add RAM to the Server.
[286830]

Restarting a stopped or failed Catalog index build
If an index has failed to build or Catalog was stopped while trying to build it, then to rebuild the index as
follows:

1. Restart Acrobat Catalog and rebuild the index (Index Build).
2. If the Search Engine says that it could not repair the index, then go to the directory with the same

name as your index description file (the .PDX file) and remove the file
 COLLECTN.STP

If an index that you wish to purge needs to be repaired in order to purge it, delete the entire index from the
File Manager. The index can be deleted instead of purged since the index is not in use. .
[289512]

DOCUMENTATION

Correction to the Acrobat Guide’s description for "Display Page to Edge"
The Acrobat Guide documentation regarding the General Preference "Display Page to Edge" should say the
following: "Some applications may create PDF documents that display a thin white border around the edge
of the page when viewed in Acrobat.  Check the Display to Page Edge checkbox to prevent this border from
being displayed."
[293190]

ASIAN FONTS

Some OCF fonts may display incorrectly on screen
Some OCF fonts (such as RodinPlus-DB by FontWorks) have incorrect font metric data that is used by
newer versions of ATM.  This incorrect data can cause the glyphs to be sized incorrectly, or to be displayed
offset from the baseline.  Though displayed incorrectly, the print output will be correct. As a workaround, turn
off the "Use Local Fonts" option in the View menu. This will cause all OCF fonts to be displayed with an
equivalent CID or TrueType font.
[289725]

Copy & paste limitations for CJK documents
Please be aware of the following limitations when selecting and copying CJK text from a PDF file and
attempting to Paste it into another application:

1. The name of the font will be different, unless PDF font name matches exactly the name of the font on the
operating system. In general, PDF files that have been created by the Distiller will have font names that do
not match font names on the OS. To workaround this problem, please select the text after it has been
pasted, and change the font to that desired.

2. Because of the way the Adobe PostScript driver creates a bold effect of a font ("synthetic bold"), text will
actually appear multiple, overlapping times in a PDF file.  Copying and pasting such text will not produce the
desired results.  The workaround is to use a heavy weight font for bold text, rather than a synthetic bold.

3. Embedded Vertical TrueType text will have a line break in pasted text whenever an alpha-numeric
character appears. There is no workaround.
 [294989]

Most CJK fonts are substituted with serif-style fonts
If a CJK font referenced in a PDF file is not on the displaying system and the font is not embedded in the
PDF file, and the serif flag is not set in the PDF file, then the font will be substituted for with a serif style
substitute font.  Unfortunately, the Distiller in Acrobat 4.0 does not set the serif flag, so most CJK fonts will
be substituted with a serif font.  If you would like to maintain the look and feel of your fonts, please embed
them in the PDF.



[293533]

3rd party Control Panels that change the User Interface
When a third-party Control Panels that changes the User Interface of the Macintosh (for example
Kaleidoscope or Aaron) is installed in your system problems with the Acrobat may occur.

1. Acrobat may not be able to find and use CJK subset fonts installed in the Resource folder, leading to
some display errors.

2. English systems with CJK language kits may not use the correct font for menus.

To remedy these problems, please remove the third-party Control Panel.
[292016]

Japanese Osaka(Mono) Roman characters are displayed in serif font
Roman characters for the Japanese Osaka(Mono) font are displayed in a serif font, although Osaka is a
sans serif. This happens only when Osaka is not available on the viewing system and font subsitution
occurs.
[288696]

Some Japanese characters may be displayed incorrectly with "Use Local Fonts"
When the View->Use Local Fonts menu item is selected, Acrobat will use the fonts available on your
system. On the Macintosh, PostScript screen fonts may be in a different encoding ((83pv-RKSJ-H) than the
standard Mac OS encoding (90pv-RKSJ-H). Because of this difference, characters in the range  x8540 and
x886d may be displayed differently than what is in the PDF file. To correct this, simply turn the "Use Local
Fonts" option off.
[290872]

CJK Notes - Changing Language of notes can cause data loss
When you right-click on a Note a pop-up menu appears with a check next to the language that the note is
written in.  If you change this between Asian languages, or between an Asian language and Roman
language, text in the Note may be changed or lost.
[287913]

CJK PostScript Printing - Expected fonts on printer
When printing to a Chinese or Korean--enabled PostScript printer Acrobat expects certain fonts to be
installed on the printer.  If the font that is used in the document is present on the printer, it will be used; if not
then the following default substitute fonts will be used, and are assumed to be on the printer.

Korean:    /Serif /HYSMyeongJo-Medium
              /SansSerif /HYGoThic-Medium

ChineseSimplified:  /Serif /STSong-Light
/SansSerif /STHeiti-Regular

ChineseTraditional: /Serif /MKai-Medium
         /SansSerif /MHei-Medium

If this is not satisfactory, please check the "Download Asian Fonts" option in the print dialog box and the
fonts available on your workstation will be used for printing.
[289269]

Japanese Full and Half-width Kana Find
’distinguish half and full width’ option behavior is as expected. When the option to distinguish between half
and full-width kana is NOT checked, Acrobat will Find all the half- and full-width, Katakana and Hiragana,
Vertical and Horizontal variants of the entered kana.  With the box  checked, only the exact entered kana
character will be found.
[289073]

Japanese character Copy and Paste problems
Some Japanese characters in the 90pv (Macintosh) character set will not Copy and Paste correctly  on
Windows, where the operating system does not support them.



[285054]

Multiple Asian language use tips
When running an operating system that has support for multiple CJK locales, there may be problems when
copying text from multi-lingual PDF files that contain Chinese characters (hanzi, kanji, or hanja).  MacOS
"Language Kits" and MacOS 8.5’s "Multilingual Internet Access" allow the user to enable multiple CJK
scripts. Microsoft’s free "Language Packs" provide the same functionality for Windows.

The problems arise  because CIDs are mapped to Unicode values to derive content.

Some Chinese characters that are unique to a single language (or locale). For example, Unicode value
U+4E6B exists only in Korean (KS X 1001:1992 Row-Cell 42-65). Such characters are handled without
problem by Acrobat since there is no ambiguity.

However, some Chinese characters are common across the CJK languages, and there is ambiguity in
deciding what language should be chosen.  For example, the Unicode value. U+4E00 maps to Simplified
Chinese (GB 2312-80 Row-Cell 50-27), Traditional Chinese (Big Five 0xA440), Japanese (JIS X 0208:1997
Row-Cell 16-76), and Korean (KS X 1001:1992 Row-Cell 76-73). There are over 2,500 Chinese characters
that fall into this category. In such cases, Acrobat may fail to correctly identify the script (language), which
causes a mis-match between the reported script and the actual encoding of the characters that are copied
then pasted into other applications.

For example, paste such a common character into an Acrobat Note and then press ctrl-click to see what
language is selected. Pasting the same character into another application may not reflect the encoding that
is reflected by the checked script.

The work-around is to paste characters into an Acrobat Note, explicitly select (or re-select to ensure that the
encoding is correct) the script, then re-copy the text. The text can now be pasted into other applications with
more predictable results.
[294351]

Quark Xpress 3.3 Users - Do Custom Install and don’t install AdobePS Printer Driver!
There is a serious incompatibility between Quark Xpress 3.3 and the CJK versions of the AdobePS 8.5
Printer Driver. To avoid this, when installing Acrobat choose a Custom Install, and do not install the Distiller
Printer.
[294599]

CJK MakeCID PS font name for an ATC font must be less than 32 characters
The MakeCID utility has a limitation when generating width-only CID fonts from the font generated by Adobe
Type Composer.  The maximum length for the PostScript font name is 31 characters. Within the ATC
application itself, the default usage will normally generate PostScript font names of 32 characters.  Please
be sure to specify a short PostScript font name when generating an ATC rearranged font if you intend to use
it for creating PDF files.
[294327]

CJK CID fonts must be installed in System Fonts folder
The Distiller is able to access CID CJK fonts only from the System->Fonts folder. If you use ATM Deluxe
and have CJK CID fonts outside the system folder, please copy them to the System->Fonts folder if you
would like to embed them in a PDF file.
[287863]

Thumbnails from Distiller and documents with double byte fonts
If you have double byte fonts in your document, the Generate Thumbnails joboption in Distiller will not work.
The workaround is to leave this option unchecked and use Acrobat to create Thumbnails afterwards.
[297315]

CJK Export EPS limitations
When you export a PDF file that contains CJK text to EPS via the ExportPS plugin, please be aware of the
following limitations:

1. You can use only the following type of fonts when producing an EPS file:
- Embedded and Non-Embedded PostScript fonts



- Embedded TrueType fonts

2. Synthetic Bold or BoldItalic fonts are not supported. (If a true heavier weight font is not available, the
PostScript driver will synthesize a bold effect by writing the character several times. This will produce an
EPS file with unexpected results.) Please select a true Bold typeface (heavier weight) instead of bold affect.

3. When printing the EPS file, the behavior is the same as traditional EPS: Only printer resident fonts are
used. If not available on the printer, they are replaced by Courier or Italic /Ryumin-Light. Note that this is a
different result than when Acrobat prints directly, in which case font substitution is done on the printer.
[290882]

Euro character will not display properly using an Asian font
Acrobat 4.0 does not support the Euro character with Asian fonts.  Please select a single-byte (Roman) font
to display the Euro character.  When selecting Euro as the Currency Format for a Forms field, be sure to
select a Roman font to display the field.
[291752]

Summarize Notes
Summarize Notes does not always display double-byte or upper ascii characters properly.
[289056]

System may crash if Acrobat is not installed after PDFWriter creates PDF file
If you set the options for PDFWriter to view the PDF file after it is created and Acrobat is not installed in
order to view the PDF file, your system may crash. Please install Acrobat to avoid this problem.
[290743]

Acrobat is required to view PDF created by PDFWriter
If you create a PDF with PDFWriter and set the option to "View PDF File" after creation, please ensure that
Acrobat is installed. If not, there may be a system error and work may be lost. Alternatively, do not check the
"View PDF File" option.
[292011]

CJK Half-width Japanese Katakana display in Acrobat 4.0
Half width Katakana in a PDF generated  with Mac PDFWriter may display as full-width Katakana in Acrobat
4.0, and cause layout differences.
[289563]

Taipei font has bad PostScript font name which is used by MakeCID
The Taipei font in the Traditional Chinese MacOS and Language Kit has a PostScript name of "????" which
will appear as the font name when the MakeCID generates the CIDFont and CompatibleFont.
[295446]

The MakeCID PPD file name is incorrect in the Dialog Box
The PPD file name "Acrobat Distiller J Custom PPD" that appears in the MakeCID dialog box should be
"Acrobat Distiller".
[295450]

TouchUp and Vertical Asian text
Editing vertical text using the TouchUp Text tool will not work as expected. Glyphs can be changed
successfully but removing a glyph will leave a vertical space and adding a glyph will append it horizontally.
[295160]
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